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LESSON 1
Quick Overview of the Access User Interface
Topics Covered

 Organization of the Access ribbon.

 Context tabs in the ribbon.

The Quick Access Toolbar.

The Navigation Pane.

 Objects and the creation process.

 Access work surface.

 Creating a database with a wizard.

Introduction

For this lesson, open the My Music Collection database located with your Webucator class
files at ClassFiles/OverviewoftheAccessUserInterface/Demos/Demo - My Music Collec

tion.accdb. If prompted concerning disabled content, click Enable Content in the yellow
banner.

❋

1.1. Access Ribbon

For this demo, we will open ../OverviewoftheAccessUserInterface/Demos/Demo - My

Music Collection.accdb.The tabbed area that spans the top of the Access window below
the title bar is called the ribbon.The ribbon holds the commands that you can use to affect
objects in Access. The commands available at any point in time depend on the type of
object you have selected and the current view mode.
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The ribbon has five standard tabs: File, Home, Create, External Data, and Database
Tools.

A new feature is the Tell me what you want to do... (not available in the web app). This
feature shows you options and takes you to an exact command, executing it along the
way. It also provides an opportunity to get help for a topic. The screenshot below shows
the results of a print search in the Tell me what you want to do...

.

 1.1.1. File

Selecting the File tab takes you to the Backstage, an area where file-level commands
can be accessed.

To return to the main Access window from the Backstage, click .

Selecting Info in the vertical menu on the left gives you access to the Compact & Repair
and Encrypt with Password utilities.
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New lets you create a new database by selecting from among numerous database
templates. To start a desktop database from scratch (as we will later in this course), you
would click the “Blank desktop database” template.
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Open lets you locate an existing database and open it. Selecting the Recent option on
the Open page shows you the database files you have used most recently. You can click
a file name to open it. Notice when you hover over items in the file list that a horizontal
push pin appears to the right of the file name. Clicking the push pin will pin the file name
to the list so that it always appears in the list unless you subsequently unpin it. Selecting
the This PC option on the Open page lets you open the current folder or recently used
folders to search for database files. Alternatively, you can click Browse to navigate to a
file.
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Save is available if you go to the Backstage when changes to database objects have not
been saved. Clicking Save saves changes to database objects and returns you to the
main window.

Save As lets you save the current database in a different file format or with a different
name, or it lets you save a database object as a different file type (e.g., save an Access
report as a PDF).

Saving as Older Format

You may have the need to save a database as an older format in order to keep the
format compliant with pre-existing environments.

By saving a database as a template, you will be able to easily replicate the functionality
and structure of a database. This is helpful when you have several similar databases to
create and roll out ensuring that once an end-user is used to the functionality of one
database, they will easily take to the other new ones without any further training.You may
also reuse query, report and forms assuming the table and field names remain the same.
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Print offers options for printing the currently selected database object.

6 | LESSON 1: Quick Overview of the Access User Interface

EVALUATION COPY: Not to be used in class.



Close closes the current database file but leaves the Access program open.

Account shows information about your product installation.
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Options opens the Access Options dialog box where you can configure settings for
Access and for the current database. The Access Options dialog box includes many
settings to personalize your experience as you work with Access and to configure the
current database according to your needs.

The left pane of the Access Options dialog box lists the categories of settings that you
can control. Highlight a category to see the settings available for that category in the right
pane. Make any changes needed in the right pane. When you are ready to apply the
changes, click OK to save the changes and close the dialog box.
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 1.1.2. Home

The commands on the Home tab are arranged in six groups:

Views - Switch among the views available for the current object.

Clipboard - Cut, copy, and paste data or objects. Apply formatting from one object
on other objects.

Sort & Filter - Sort data. Apply quick filters or filter by form.
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Records - Maintain records. Add a total row. Perform spell check.

Find - Find records that match your criteria. Perform search and replace.

Text Formatting - Change font styling, text justification, text color, bulleting.

 1.1.3. Create

The commands on the Create tab are arranged in six groups:

Templates - Create a database object from a template.

Tables - Create a table in Datasheet view or Design view.

Queries - Create a query using a wizard or in Design view.

Forms - Create a form using a wizard or in Design view. Create specialized forms.

Reports - Create a report using a wizard or in Design view. Create labels using
a wizard.

Macros & Code - Add and organize macros to automate tasks.

Wizards throughout Access will allow you to ease into the creation process as the Wizards
lead you through the choices and options available. Most objects offer one, if not several,
wizards to choose from.

 1.1.4. External Data

The commands on the External Data tab are arranged in two groups:

Import & Link - Import data from a variety of data sources.

Export - Export data from the database in a variety of formats.
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 1.1.5. Database Tools

The commands on the Database Tools tab are arranged in six groups:

Tools - Compact and repair the database.

Macro - Access the Visual Basic for Applications editor. Run a macro.

Relationships - Define relationships between tables in the database.

Analyze - Analyze database objects for performance. Analyze tables for
unnecessary data duplication.

Move Data - Prepare the database for sharing with others.

Add-Ins - Manage optional add-in features.

In this course and in the advanced course, we’ll use commands from all the ribbons;
however, our primary focus in this course will be on tools available in the Home and Create
tabs.

 1.1.6. Contextual Tabs

As you work with objects in Access, you may notice that additional tabs become available
in the ribbon depending on the object you are working with and the view mode you are in.
For example, when a table is open in Datasheet view, a Table Tools tab with two sub-tabs,
Fields and Table, is visible.

Tabs like these are called contextual tabs. They provide specific additional tools for the
object you are currently working with.

❋
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1.2. Quick Access Toolbar

The Quick Access Toolbar is a customizable set of icons that typically displays above
the ribbon to give you easy access to common commands such as Save, Undo, and
Redo.

To use a command in the Quick Access Toolbar, simply click its icon.You can customize
the toolbar to show whichever commands you prefer.

To add more common commands to the Quick Access Toolbar:

1. Click the drop-down arrow at the right end of the Quick Access Toolbar to open
the Customize Quick Access Toolbar menu.

Note that commands already on the Quick Access Toolbar have a check mark
to their left in the menu.

2. From the menu, select the command you want to add to the toolbar. Its icon is
immediately added to the toolbar.

To remove a common command from the Quick Access Toolbar:

1. Click the Quick Access Toolbar drop-down arrow.
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2. From the menu, select the check-marked command you want to remove from the
toolbar. Its icon is immediately removed.

Any command that is available in Access can be added to the Quick Access Toolbar.
To do so, you use the Access Options dialog box.

To customize the Quick Access Toolbar using the Access Options dialog box:

1. Click the Quick Access Toolbar drop-down arrow and select More Commands....
The Access Options dialog box opens with the Quick Access Toolbar category
already selected.

2. In the left list box, locate and highlight the command to add to the Quick Access
Toolbar.

3. Click Add. The command moves to the right list box.

4. Click OK. The command is added to the Quick Access Toolbar.

❋

1.3. Object Navigation Pane

Along the left side of the main Access window is the Navigation Pane. The Navigation
Pane shows the database objects that are part of your database application. Use the pane
to open the database objects you want to work with.
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If you need additional work area, the Navigation Pane can be collapsed by clicking the
shutter bar button in the upper right corner of the pane.
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To restore the pane, click the shutter bar button on the collapsed pane.

The Navigation Pane can be filtered by category and by object type. To do so, click the
drop-down arrow at the top of the pane and select the desired category from the Navigate
To Category section of the drop-down menu. After you select a category, you can open
the drop-down menu again and select the group to filter by in the lower section of the
menu. The groups change depending on the category selected. The pane title changes
to match the group you select.
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The Navigation Pane provides easy access to your database objects. To open an object,
double-click on its name in the Navigation Pane.
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❋

1.4. Access Work Surface

When you open an object from the Navigation Pane, the object appears in a tab on the
Access work surface. The work surface is where you perform most of the tasks related to
creating and maintaining a database. You can open multiple objects on the work surface
at the same time. Each object appears in a separate tab.
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To make an object active so you can work with it, select its tab. To close an object, select
it and then click the X at the far right end of the tab.

❋
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1.5. Object Overview

 1.5.1. Tables

Tables are the storage vessel for your data. Careful planning and arrangement of the fields
that make up each table with consideration of the relationships between them make for a
well rounded relational database design. If this foundation is prepared well, the rest of the
objects that you create will be a smooth process.

 1.5.2. Queries

Queries are designed to pull the relevant data form each table to create a recordset which
can be used as the basis of you reports or to analyze the data in a meaningful way.

 1.5.3. Forms

Forms present an opportunity to create a user interface for data entry that may be
customized to fit your audience needs. Forms may be based off of Tables for data entry,
or Queries for on screen reports and analysis.

 1.5.4. Reports

Reports are used to create a Query or Table data that presents well in a print format.They
may be customized and also saved out as a PDF file type for on screen viewing.

 1.5.5. Macros and Modules

Macros and modules allow you to automate database functions and to provide additional
functionality. Macros are built by selecting from a list of actions and combining actions to
produce the effect you want. Modules are collections of functions and procedures written
in the Visual Basic for Applications (VBA) language.

Macros and modules are beyond the scope of this course; however, the advanced course
will demonstrate how to use basic macros to automate forms and reports.

❋
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1.6. Process Overview

The general process of building a database begins well before we approach Access to
build the corresponding objects that make up the database. We need to step back and
research the needs and resources available. Creation of a plan will help to keep you and
your team on track as well as provide the visuals to explain the logic to others that will
interact with your database. We will delve deeper in to the research and planning phases
later in the course making sure you have a full understanding of the process start to finish
regardless of your responsibilities in the project. The full understanding helps you better
communicate with others on the team.
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 Exercise 1: Getting Around the Access
Environment

 15 to 25 minutes

Using the “Exercise - My Music Collection” database located at Class

Files/OverviewoftheAccessUserInterface/Exercises/Exercise - My Music Collec

tion.accdb, perform the following tasks:

1. Pin the database file to the Recent files list.

2. Add the Quick Print icon to the Quick Access Toolbar.

3. Filter the Navigation Pane so that only tables appear in the list.
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Solution

To pin the database file to the Recent files list:

1. Select the FILE tab.

2. Select Open and Browse.

3. LocateClassFiles/OverviewoftheAccessUserInterface/Exercises/Exercise -

My Music Collection.accdb and click Open.
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4. In the Recent files list, locate Exercise - My Music Collection.accdb and hover
over the file name until you see the horizontal push pin. Click the push pin The
file moves above the list separator and is denoted with an upright push pin.

LESSON 1: Quick Overview of the Access User Interface | 23



To add the Quick Print icon to the Quick Access Toolbar:

1. Return to the Home tab. If you’re in the Backstage, click .

2. Click the Quick Access Toolbar drop-down arrow and select Quick Print from
the drop-down menu. The icon is added to the toolbar.
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To filter the Navigation Pane so that only tables appear in the list of objects:

1. In the Navigation Pane, click the drop-down arrow in the pane title bar to open
the drop-down menu. In the Navigate To Category section of the menu, ensure
that Object Type is selected.
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2. Click the drop-down arrow again and select Tables in the Filter By Group section
of the menu.

❋

1.7. Create a Database Using a Wizard

When creating a new database, you have choices to use pre-made databases.These can
be found on the internet, or many organizations may provide custom databases for their
employees.

1. File > New > Search for the topic.
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2. Single click upon the database of choice.
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3. Choose a location and a name for the database. Click Create.

4. You may be presented with a Welcome screen depending on your template choice.
Click Get Started.

5. The database is now ready for use.
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The databases available may not always be exactly what you need, but they are a good
start. Tables and other objects may be added or deleted as needed.

Conclusion

In this lesson, you learned:

To find your way around the Access environment.

To customize elements such as the Quick Access Toolbar and Navigation Pane
to suit your preferences.

To open objects on the Access work surface so that you’ll be ready to learn more
about the creation process.
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LESSON 2
Fundamentals

Topics Covered

 Considerations before creating a database application.

 Common approaches to database design.

 Data mapping.

 Naming conventions.

 Normalization.

 Primary and foreign keys.

 Relationships among tables.

Introduction

Now that you’re acquainted with some of the tools Access puts at your disposal, let’s get
started. While it may be tempting to dive in and start creating tables right away, a little
planning will go a long way to ensure that your database meets your users’ needs and
performs efficiently.

❋

2.1. Questions to Ask Before You Start

The clearer your mental image of what you want your finished database application to
look like, the easier it will be to achieve it. In this section, we’ll consider some questions
to help you visualize the finished result.

 2.1.1. What is the purpose of the database?

It’s important to clarify why you’re creating the database application in the first place.What
need will the database satisfy? Who needs it? Knowing your purpose and keeping it in
mind as you work will keep you on track and ward off “feature creep” (the tendency to add
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unnecessary features just because you can). As you plan and build your database
application, continually ask yourself, “Does it serve my central purpose?”

 2.1.2. Who will use the database?

Knowing who will use your database will help you make informed choices as you design
and build it. Things to consider are your users’ skill level, job function, and information
requirements. Also, recognize that you may have users who aren’t “hands on” users but
who may be relying on the output from your database nonetheless.

 2.1.3. What kind of output is needed from the database?

Will the database need to generate reports? Form letters? Invoices? Charts and graphs?
What kind of questions do users need the database to provide answers to?

 2.1.4. What process is the database replacing or improving?

Are you automating a task that’s been done manually thus far? Are you replacing a
spreadsheet or another database? If so, why is it being replaced? How will your proposed
database solution make the current process better?
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 Exercise 2: Asking Questions
 15 to 25 minutes

Reflecting on a database project you have in mind, answer the four questions posed in
this section. If you don’t have a project in mind, you can make one up.

1. What is the purpose of the database?

2. Who will use the database?

3. What kind of output is needed from the database?

4. What process is the database replacing or improving?

❋

2.2. Approaches to Database Design

How you approach designing a database depends largely on what you know when you
start. The most common approaches to database design are called top-down and
bottom-up. Other design approaches are typically a variation on one of these methods or
a mixture of the two.

 2.2.1. Top-Down Database Design

If you are starting with a general concept and need to work down to the details, your project
is a candidate for top-down design. In top-down design, you start with an abstract idea
and gradually refine it until you arrive at the fundamental elements of the system. The
top-down approach often involves interviewing prospective end users to learn their
requirements for the system. The risk in top-down design is overlooking a critical need.
The challenge in top-down design is to translate the end users’ requirements into the
simplest workable design.

 2.2.2. Bottom-Up Database Design

As you may have guessed, bottom-up design starts with the details and works up to a
unified concept. Bottom-up design typically starts with examining existing reports, forms,
user interfaces, etc., to glean the information that needs to be incorporated in the system.
With these details in hand, you work backward to design the structures that store the
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information in an optimal way. A challenge in bottom-up design is weeding out information
that is irrelevant.

 2.2.3. Reality

In reality, the approach you take on most projects will probably resemble a mixture of the
two methods rather than strictly one or the other. While you may be knowledgeable of
some aspects of a project, you may also need to rely on others who have better first-hand
knowledge of other aspects of the project.

In this course, we’ll assume that we are experts on the subject of the database and adopt
a mostly bottom-up approach to database design.

❋

2.3. Gather Information

Our present goal is to identify the information that needs to be stored in the database and
to organize it in a logical way. The following steps describe a strategy for doing this:

1. Collect data.

A. Gather any existing forms, reports, and other documents that are relevant
to the purpose of the database. For the My Music Collection database,
“documents” included record jackets, CD and cassette inserts, electronic
data from MP3 files, and information from music-related websites. For an
accounting system, you might collect invoices, purchase orders, receipts,
reports required by the government and by other departments, etc.

B. Talk to users about the data they need the database to store and the
information they need the database to return.

C. If your database is replacing a current system, look at the system’s
interface and note the data that it collects and outputs. Discover the
reasons the system is being replaced and take those into account as you
build your project.

2. Categorize the data to determine the main objects the database needs to manage.
These objects may range from people to transactions to inventory items to events
to... These main objects typically become the basis for tables in your database.

As you categorize the data, try to weed out irrelevant data including data
you don’t need and data that you can derive from other data that will be
stored in the database. For example, suppose in an employee database
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you will store first names, middle names, and last names. There is no
need to include a full name column because the full name can be derived
from the individual parts of a name. Storing the full name in addition to the
parts wastes disk space and data input effort.

3. Write the main objects down and list the types of data you need to collect about
each main object. For example, if a main object is “employee,” you might list name,
social security number, address, phone number, birth date, job, etc.The information
you store about a main object forms the columns in its table.

4. Determine how the main objects are related to one another. Often working through
this step will help you identify additional objects that can be separated off and
stored in their own tables. For example, we listed “job” as information you might
collect for an employee. However, when we consider that several employees might
have the same job and that we may want to store details that vary depending on
the job (like supervisor and work location), we start to see why it could make sense
to have a separate job table. Storing job-related data only on a job record reduces
the possibility that two employees with the same job will show up on reports with
different job titles (e.g., “entry clerk” and “data entry clerk”). In addition, when a
new employee record is created, the user doesn’t need to enter a job and all the
related details of the job; instead, the user simply assigns the appropriate job
record to the employee record and the job details are automatically associated
with the employee. We’ll discuss a systematic way to tease apart data like this in
the “Normalization” section.

The Right Design

There is not a definitive “right” design for a database. It is fair to say that some designs
are better than others. In the discussions and exercises which follow, recognize that
the solutions offered represent one way, but not the only way, to structure the
database. The principles in this course are simply intended to help you design a
database for optimal function and efficiency.

 2.3.1. Data Mapping

Often it is helpful to represent the plan in a visual manner in order to make a clear road
map for all to follow. Please look at the data map below that is representing the contact
data for our clients. You may add to this and plan out the inventory and purchase history
related to each client.
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Notice the way each table has a unique ID field (primary key) and some have a reference
to others (foreign key). This is the foundation of our relationships discussed later in this
lesson. Also, each table has a single topic, that when presented with the chance of
multiples, the item that may have multiples has generated a new table (this is the foundation
of Normalization discussed later in this lesson). Each field has a notation of a data type
that will be helpful when we actually build this table in Access.

In brief, each table in a database should have a single focus. When you notice that
secondary items in the table are repeating, it’s a signal to break the repeating topic into a
table of its own and assign it its own primary key. This primary key becomes the source
for a foreign key field in the original table. For the sake of good organization, though
optional, the primary key and foreign key should share the same name and must be of
similar data type.

There are three relationships possible between tables, to be covered in full later on.

One-to-many. Table A has a one-to-many relationship with Table B if a record in
Table A can match one or more records in Table B but each record in Table B
must match only one record in Table A.

Many-to-many. Table A has a many-to-many relationship with Table B if Table A
can have one or more matches in Table B and Table B can have one or more
matches in Table A.

One-to-one. Table A has a one-to-one relationship with Table B if Table A can
have no more than one matching record in Table B and Table B can have no more
than one matching record in Table A.
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 2.3.2. Sample Data Map
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Above we have planned out the tables of a Client - Sales - Inventory database. Think
about the Client and Purchase Order portions of our database. Talk about the data you
would need to collect to keep track of what we sell and when it was sold. How many tables
would you need? What are they? What related information would each table store? How
are the tables related to one another? Would you include any other tables other than the
ones shown? There are no true right or wrong answers, however try to make your design
as efficient as possible ensuring data is only entered once, and then referenced from then
out in the future.

❋

2.4. A Few Words about Naming Conventions

In this course and in the advanced course we will not impose a structure on the names of
our database objects.This will make it more natural to refer to database objects in context.
However, for larger or more complex databases you will want to consider using a naming
convention to help you distinguish among objects. Using a naming convention is particularly
helpful if other people may maintain your application.
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A commonly used convention for Access databases is the Leszynski/Reddick naming
convention. Briefly, this convention adds a tag in lower case letters before the object name
and omits all spaces.

ExampleTagObject Type

tblRecordingstblTable

tlkpFormatstlkpTable Lookup

qryCDRecordingsqryQuery

qappRecordingsAction Query q a p p
(append)

q x t b
(crosstab)

q d e l
(delete)

q m a k
( m a k e
table)

qry or qsel
(select)

q u p d
(update)

frmRecordingEntryfrmForm

sfrmCompilationssfrmSubform

rptMusicListrptReport

srptCompilationssrptSubreport

mcrAddRecordingsmcrMacro

cmdOpenRecordingsFormcmdCommand

A variant of the Leszynski/Reddick convention includes an underscore between the tag
name and the object name: tbl_Recordings.

A similar naming convention has the advantage of making it easy to distinguish among
object types like the Leszynski/Reddick convention does, but has the added benefit of
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being easier to search. By this convention we append a tag in upper case letters to the
end of the object name while omitting all spaces.

ExampleTagObject Type

RecordingsTBLTBLTable

FormatsLKUPLKUPTable Lookup

CDRecordingsQRYQRYQuery

APPEND_RecordingsQRYAPPEND_ObjectNameQRY
XTAB_ObjectNameQRY
DELETE_ObjectNameQRY
MAKE_ObjectNameQRY
SELECT_ObjectNameQRY
UPDATE_ObjectNameQRY

Action Query

RecordingEntryFRMFRMForm

CompilationsSFRMSFRMSubform

MusicListRPTRPTReport

CompilationsSRPTSRPTSubreport

AddRecordingsMCRMCRMacro

OpenRecordingsCMDCMDCommand

Whichever convention you choose, it is important to use it consistently across your
application.
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 Exercise 3: Gathering Information
 15 to 45 minutes

Looking at the check, check register, deposit slip, and bank statement provided, what sort
of data would you collect to create an application for recording and reconciling bank
transactions? What main object(s) would you organize the data around? Describe or sketch
out the table(s) you would create.
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Solution

Solutions to this exercise will vary. A couple of possible solutions follow:

1. Tables: Debits, Credits

Debits

Fields: Transaction Number, Date, Payee, Amount, Memo, Status
(Cleared, Not Cleared)

Credits

Fields: Transaction Code, Date, Description, Amount, Status (Cleared,
Not Cleared)

2. Table: Transactions

Transactions

Fields: Transaction Code, Transaction Type (Debit, Credit), Date,
Description, Amount, Memo, Status (Cleared, Not Cleared)

How did you do?

Think through your solution. Did you omit any data that would be needed? Did you
include unnecessary data?

❋

2.5. Normalization

Normalization is the process of organizing data in a way that promotes efficient data
processing. Normalizing data entails breaking data into tables of related information and
defining relationships among the tables.

If our definition sounds a bit subjective, it is. Normalization is a matter of degrees. In fact,
the degree of normalization of a data set is referred to as its normal form. While there are
several normal forms, we will concern ourselves with the first three normal forms, each
form progressively more “normal” than the prior form.

The benefits of normalization include:

Data integrity. Normalization eliminates redundant data and orphaned data.
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Database efficiency. Normalization improves the speed of queries.

To illustrate the normalization process, we’ll start with the following unnormalized data
set. (In some texts an unnormalized data set is referred to as being in Zero Normal Form).

 2.5.1. First Normal Form

The goal of First Normal Form is to eliminate repeating groups. Examine the
Employee-Department-Skill table and notice that some employees have multiple skills
listed, resulting in some employees appearing in the table more than once.

There are two steps to achieving First Normal Form:

1. Create a separate table for each related set of data.

2. Assign a primary key field to each table.

For the Employee-Department-Skill table, this means first moving the employee and
department information to its own table.
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Next, we need to assign the new table a primary key. A primary key uniquely identifies a
record in a table. A primary key field can be a field already in the table itself (e.g., social
security numbers are often used as primary keys since they are unique to individuals) or
a primary key field can be a field added to a table that generates unique identifiers as
records are added to the table. This second type of primary key field has no intrinsic
meaning; it simply serves as a means to ensure that records are unique.

Composite Primary Keys

A primary key can also be defined on a group of fields which together uniquely identify
a record. This is called a composite primary key.

You may have noticed that when we created tables in the “Table Objects and Their Views”
lesson, Access automatically added a first column labeled “ID” to the tables. Whenever
you create a table in Datasheet view, Access adds an ID column to serve as a primary
key to ensure that records in the table are unique. As we will see in the next lesson, Design
view allows you to determine the primary key field.

When we add a primary key field to the Employee-Department table, our result looks like
this:
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So the original Employee-Department-Skill table is equivalent to this table:

Finally, we need to assign the Employee-Skill table its own primary key field.
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Notice that in the resulting tables, employees appear only once in the Employee-Department
table, but they may be referenced multiple times in the Employee-Skill table.This is known
as a one-to-many relationship.
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 2.5.2. Second Normal Form

The goal of Second Normal Form is to eliminate redundant data.

There are two steps to achieving Second Normal Form:

1. Satisfy the requirements of First Normal Form.

2. Identify data that is redundant and separate it into another table.

Notice that some skills and their descriptions in the Employee-Skill table are redundant.

This redundancy suggests that we should create a separate table for skills:
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This reduces the Employee-Skill table to:

Because the Employee ID and Skill ID together determine the same information provided
by the Employee-Skill ID, we can eliminate the Employee-Skill ID column altogether and
use the Employee ID and Skill ID together as a composite primary key. This results in the
following Employee-Skill table:
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Notice that in the resulting tables there is only one instance of each skill in the Skill table
but multiple employees may be assigned the same skill in the Employee-Skill table, another
one-to-many relationship.

 2.5.3. Third Normal Form

Third Normal Form has two requirements:

1. Satisfy the requirements of Second Normal Form.

2. Remove columns in a table that do not directly depend on the table’s primary key.

Let’s return to the Employee-Department table.
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In the Employee-Department table, the Department column depends on the Employee (if
I know the employee, I know the department) and the Employee column depends on the
Employee ID (if I know the Employee ID, I know the employee), but the Department does
not depend on the Employee ID directly (if I know the employee ID I cannot be sure of the
department). Because the Department column does not directly depend on the Employee
ID, departments need to be moved to a separate table.

After we create a separate Department table and replace the Department field in the
Employee-Department table with the Department ID field, the result is two tables:
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The Department ID field in the Employee table is an example of a foreign key. A foreign
key is a field in a relational database table that matches the primary key of another table.
Foreign keys establish a relationship between tables and are vital to maintaining data
integrity.

To recap, to achieve Third Normal Form in your tables:

1. Eliminate repeating groups.

2. Eliminate redundant data.

3. Remove columns which do not directly depend on the primary key.

❋

2.6. Table Relationships

In the process of our work to normalize the tables in the example, we defined relationships
among the tables.

The Department table has a one-to-many relationship with the Employee table.

The Employee table has a one-to-many relationship with the Employee-Skill table and the
Skill table likewise has a one-to-many relationship with the Employee-Skill table.
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 2.6.1. Relationship Types

There are three types of relationships among tables. For table A and table B:

Table A has a one-to-many relationship with Table B if a record in Table A can
match one or more records in Table B but each record in Table B must match only
one record in Table A. In our example, we arrived at three one-to-many
relationships: the Department table to the Employee table, the Employee table to
the Employee-Skill table, and the Skill table to the Employee-Skill table.
One-to-many relationships are the most common type of table relationship.

Table A has a many-to-many relationship with Table B if Table A can have one
or more matches in Table B and Table B can have one or more matches in Table
A. This sort of relationship occurs when a third table, called a junction table, is
defined which consists of a foreign key from Table A and a foreign key from Table
B. The Employee table and the Skill table in this lesson’s example have a
many-to-many relationship with the Employee-Skill table acting as the junction
table.

Table A has a one-to-one relationship with Table B if a record in Table A can have
no more than one matching record in Table B and Table B can have no more than
one matching record in Table A.This type of relationship is less common because
most data with this sort of relationship could be stored in the same table. At times,
however, such a relationship is useful.
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 Exercise 4: Normalizing Data
 30 to 45 minutes

Consider the following Transactions table. Use normalization techniques to achieve tables
which satisfy Third Normal Form.
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Solution

First Normal Form

The Transactions table has no repeating data. To establish First Normal Form, we only
need to assign a primary key field to the table.

Second Normal Form

Notice that the Type and Status columns contain redundant data. We need to remove
these columns to their own tables and assign primary keys.

When we replace the Type and Status columns as foreign keys, the Transactions table
looks like this:
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Third Normal Form

All columns in the Transactions, Transaction Types, and Statuses tables depend on their
respective primary keys. There is nothing further to do to achieve Third Normal Form.

Conclusion

In this lesson, you learned:

How to get started designing a database application.

About naming conventions for tables and other objects.

What normalization is and how to normalize tables to conform to Third Normal
Form.

About primary keys and assigning a primary key to a table.

About foreign keys and using them to establish relationships among tables.
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LESSON 3
Tables and Their Views

Topics Covered

Tables and table views.

Tables in Datasheet view.

 Data records in Datasheet view.

The purpose of Design view.

Introduction

Access provides five types of database objects: tables, queries, forms, reports, and macros
and modules. This lesson focuses on tables, the essential database objects. The next
lesson looks at the remaining database objects. These add the functionality that enhance
data access for your end users.

For this lesson, open the My Music Collection database located with your Webucator class
files at ...\ClassFiles\TablesTheirViews\Demos\Demo - My Music Collection.accdb. If
prompted concerning disabled content, click Enable Content in the yellow banner.

❋

3.1. Definition and Purpose

Tables are the core structure of a database.They store related data in a logical framework
of rows and columns that makes it easy for an RDBMS to sort, filter, and retrieve
information.
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The first row of a database table contains column headings.The column headings are the
names of the fields in the table.

Each column in a table represents a field. Each entry in a field is a field value.

Each row in the table represents a record. A record consists of a value for each field in
the table. (For this definition, we’re including “blank” as a field value if the database rules
allow a blank field value.)

❋

3.2. Datasheet View

Access provides two ways to work with tables: Datasheet view and Design view.

Datasheet view shows a table in typical column and row layout.
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Datasheet view provides a number of features for working with a table and its data.

 3.2.1. Selection Tools

Select a Table

If you need to make a change that affects all the data in a table, you first need to select
everything in the table.

To select a table, click the table selector in the upper left corner of the table.

The entire table is highlighted.

LESSON 3: Tables and Their Views | 61



Select a Column

If you need to make a change that affects a column, you first need to select the column.

To select a column:

1. Hover the mouse pointer over the column you need to select until it changes to a
downward arrow.

2. Click. The column is highlighted.
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To select multiple adjacent columns, select the first column you need, then press Shift
and select the last column you need.

Select a Row

If you need to make a change that affects a row, you first need to select the row.

To select a row:

1. Hover over the record selector to the left of the row you need to select.The mouse
pointer changes to a right arrow.

2. Click. The row is highlighted.
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To select multiple adjacent rows, select the first row you need, then press Shift and select
the last row.

 3.2.2. Table Layout Tools

Reorder Columns

To move a column to a different location in the table:

1. Select the column.

2. Click in the heading of the selected column.
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3. Drag the column to a new location. Notice that a bold separator indicates the
positions where you can place the column.

4. When you arrive at the desired position, release the mouse button to finish the
move.
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Resize a Column

You can make columns wider or narrower to suit your needs.

To change the width of a column:

1. On the right end of the column heading, hover over the column separator until the
cursor changes to .

2. Click and drag to the left to make the column narrower; drag to the right to make
it wider.

3. When you achieve the desired width, release the mouse button.
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You can quickly resize a column to fit the width of the longest displayed record value in
the column. To do so, double-click the column separator.
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Resize Rows

Where as resizing columns affects only the selected column, resizing rows affects all rows
in the table.

To resize the rows in a table:

1. Hover over the divider between two record selectors until the cursor changes to
.

2. Click and drag down to make the rows taller; drag up to make the rows shorter.

3. When you reach the desired row height, release the mouse button.
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Hide a Field

Hiding a field will affect the view of the table without harming the data.

To a field in a table:

1. Right-Click on the field you wish to hide. Choose Hide Fields.

Display the Totals Row

When you need a quick summation from a table, we may use the Totals Row feature.
Depending on the type of data in the column, your choices as to how the calculation will
be generated will differ.

Totals Row in a Table:

1. Home > Records > Totals.

2. In the column that needs a summation, click and choose a function.
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3. The calculation is processed.

Save Layout Changes

To keep changes to the layout of a database table, you must save the table. If you do not
save beforehand, Access will prompt you when you try to close the table.

70 | LESSON 3: Tables and Their Views

EVALUATION COPY: Not to be used in class.



 3.2.3. Sorting and Filtering Tools

Data can be sorted and filtered by using the commands available in drop-down menus on
the column headings. The options available vary depending on the type of data a column
stores; however, the basic methods are similar regardless of data type.

Sort Data

To sort data by the values in a particular column:

1. Click the down arrow to the right of the column name to open the drop-down menu.

2. From the menu, select the option next to the  icon to sort in ascending order or

select the option next to the  icon to sort in descending order.
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Filter Data by Value

To filter data by specific value(s) in a column:

1. Click the down arrow to the right of the column name to open the drop-down menu.

2. In the list box, clear the (Select All) check box. This clears all the check boxes in
the list box.

3. Mark the check box for each value you want to include in the filtered results.
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The (Blanks) Option

The (Blanks) option lets you see the records which don’t have a value
specified in the column.

4. Click OK. Only the records which match your selections show in the datasheet.

After you apply a filter, an indicator appears in the record navigation bar at the bottom of
the tab to indicate that the dataset is filtered.
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Click the Filtered button to remove filtering and show all records in the table.

Filter by Criteria

To filter a table by specifying criteria:

1. Click the down arrow to the right of the column name to open the drop-down menu
and select the Filters option. Depending on the type of data stored in the column,
this option may be labeled “Text Filters”, “Number Filters”, “Date Filters”, etc.
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2. From the submenu, select how you want to compare values to determine if a
record belongs in the filtered dataset.You are prompted for a value.

3. Type the value that you need to satisfy the statement.

4. Click OK. Only the records which satisfy your criteria show in the table.
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 3.2.4. Print Records

Once you have the perfect recordset, you may wish to print, save as a PDF, or export the
recordset out to another format.

Print a Recordset:

1. Choose File > Print > Print Preview.

2. View and print as desired.

Export a Recordset to Excel:

1. Choose External Data > Export > Excel to open the export wizard.

2. Choose a location and then click OK.
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3. Your recordset data has now been saved as an Excel spreadsheet.

 3.2.5. Record Navigation

At the bottom of a table’s tab is the record navigation bar.

The first section of the bar is the record navigator. The buttons of the record navigator
allow you to move quickly to the first record , the previous record , the next record ,
and the last record  in the table. The last button  in the record navigator adds a new
blank record to the table.
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In the middle of the record navigator is the current record indicator which shows the record
currently selected in the table and the total number of records in the table.You can select
the text in the current record box, type a record number, and press Enter to move quickly
to that record in the table.

To the right of the record navigator is a button that indicates whether the table is filtered
or unfiltered. Clicking Unfiltered applies the last saved filter on the table. As noted earlier,
clicking Filtered removes filtering.

The last item on the record navigator is a search box.

As you type in the search box, the cursor moves to the first value in the table that matches
what you’ve typed. After you find your search term, you can press Enter again to find the
next instance of the search term in the table.
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 3.2.6. Working in Datasheet View

Open a Table

To open an existing table in Datasheet view:

1. Locate the table in the Navigation Pane.

2. Double-click the table name.

Create a New Table

To create a new table in Datasheet view:

1. Select the Create tab.
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2. In the Tables group, click Table. A new table with a default name of “Table1” is
added to the work surface.

3. Add fields to the table as needed.To do so, click Click to Add  in the first available
column.
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4. From the drop-down menu, select an appropriate data type.The new field is added
using a default name. Notice that the default name is highlighted and editable.

5. Type a meaningful name for the field.

6. Continue adding more fields as needed.

7. When you finish, click Save.You are prompted for a table name.

8. In the Table Name field, type a descriptive name for the table.
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9. Click OK.

Add and Edit Data

Data records can be added and edited directly in Datasheet view.

The last row in a data table is ready for new data entry.The asterisk on the record selector
indicates the new record. The ID field indicates “(New)”. After you start typing in the first
empty field, Access will replace “(New)” with a unique value and add another new row to
the table.

To add a new record:

1. In the last row of the table, start typing values for the fields in the new record.
Press Tab to move from field to field.
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2. Press Tab after you fill in the last field to move to the next row.

Automatic Saving

New records and changes to records are immediately saved to the database. You
do not need to click Save to save data. The Save command applies to database
objects only.

To change a value in an existing record:

1. Locate the record you need to change.

2. Place your cursor in the field you need to change, highlighting all or part of the
entry as necessary.

3. Correct the value.

Delete a Record

When a record has served its purpose, deletion is an option available. Once the record
has been deleted, there is no recovery.
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1. Right-click the record in question.

2. Choose Delete Record.

Find and Replace Data

When mass changes need to be made, Find and Replace is available.

1. Click Home > Find > Replace.

2. The Find and Replace dialog box appears. Choose your settings.
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3. Once a match is found, click Replace. Click Yes.

Close a Table

To close a table:

1. Click the X at the top right corner of the table tab. If you’ve made changes to the
table, you are prompted to save your changes.

2. If you want to save the changes, click Yes.

Delete a Table

To delete a table:

1. If the table is open, close it.

2. Highlight the table name in the Navigation Pane.

3. Right-click and select Delete from the shortcut menu.You are prompted to confirm
your action.

4. Click Yes.
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Caution!

Exercise caution when deleting tables. Deleting a table that other tables or other
database objects depend on can introduce errors, data inconsistency, and functional
anomalies.
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 Exercise 5: Working with Tables in
Datasheet View

 15 to 25 minutes

In this exercise, you will add records to a table, create a new table, sort the data in a table,
and apply a filter to the data in a table.

Open the Exercise - My Music Collection database located in your class files at
...\ClassFiles\TablesTheirViews\Exercises\Exercise - My Music Collection.accdb
and then do the following:

1. Add the following data records to the Recordings table:

FormatArtistTitle

33D’Oyly Carte Opera CompanyPirates of Penzance

MP3AdeleSkyfall

2. Create a new table named “Artists” with a field named “Artist”. Add a record for
each distinct artist found in the Recordings table. In other words, if an artist appears
more than once in the Recordings table, only add it once to the Artists table.

3. Resize the Artist column in the Artists table so that the full name of every artist in
the table is visible.

4. Sort the Artists table in alphabetical order.

5. Filter the Artists table to show only artists with the word “Orchestra” in their names.

❋

3.3. Design View

While Datasheet view lets you work directly with the data in tables, Design view takes you
behind the scenes to work with the table structure. In Design view you have much finer
control over how the fields in your data are defined and validated.

 3.3.1. Open a Table in Design View

To open a closed table in Design view:
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1. Locate the table in the Navigation Pane and right-click it.

2. From the shortcut menu, select Design View. The table object opens as a tab on
the work surface.
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If a table is already open in Datasheet view, you can switch to Design view by clicking the
View icon in the toolbar.

 3.3.2. Design View Layout

The Design view for a table is divided into three main sections: the field definition area,
the field properties tabs, and the user assistance text.

The field definition area spans the top of the tab. Here you can add fields, specify their
data types, and provide descriptions that users can see when they enter the field while
using your application.

The field properties area is located at the bottom left of the tab. The items on the Field
Properties tabs represent the properties of the field that is currently selected in the field
definition area.
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The user assistance text is located at the bottom right. The text provides guidance for the
object where your cursor is currently placed.

We’ll look in more depth at Design view for tables in a future lesson.

Conclusion

In this lesson, you learned:

About the table object in Access.
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About the views available for working with tables: Datasheet view and Design
view.

About working with tables in Datasheet view.
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LESSON 4
Tables

Topics Covered

 Creating an Access database.

 Creating a table in Design view.

 Data types.

 Assigning a key field.

 Input masks.

 Defining validation rules.

Introduction

For this lesson, open the My Music Collection database located with your Webucator class
files at.ClassFiles/Tables/Demos/Demo - Contacts.accdb. If prompted concerning disabled
content, click Enable Content in the yellow banner.

❋

4.1. Creating an Access Database

So far we’ve worked with existing databases. Now it’s time to create our own database
and start developing our first application.

To create a blank Access database:

1. Start Access.
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2. Click Blank desktop database.

3. In the File Name field, type a name for the new database.

4. To save to a different location than the default saving location, click the folder icon.
The File New Database dialog opens.
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5. Navigate to and select the folder where you want to save the database file.

6. Click OK.
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7. Click Create. Access opens the new database file and creates a blank table for
you.
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 Exercise 6: Creating a New Database
 15 to 25 minutes

In this exercise, you will create a database using the blank database template. Save the
database in your .../ClassFiles/Tables/Exercises folder and name it “Bank
Register.accdb”.
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Solution

To create the database:

1. Start Access.

2. Click Blank desktop database.
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3. In the File Name field, type “Bank Register.accdb”.

4. Click the folder icon and navigate to and select the folder where you want to save
the database file.

5. Click OK.

6. Click Create.Your new database opens.

❋
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4.2. Data Types

When we create tables, Access allows us to specify the kind of data that will be stored in
each column.This lets us take advantage of robust features like data validation and built-in
functions that enhance the reliability of data entry and output. The following table
summarizes the data types available.

DescriptionData Type

Alphanumeric text (letters and/or numbers) up to 255 characters.Short text

Alphanumeric text that can exceed 255 characters.Long text

NumbersNumber

Dates and timesDate/Time

Monetary amountsCurrency

Unique numbers generated by Access to identify new records.AutoNumber

For data that is either true or false. Access stores false values as the number
0 and true values as -1.

Yes/No

Objects from other Windows applications.OLE object

A link to a file or location on the Internet, on a network, or on the user’s
computer.

Hyperlink

A file such as a document, spreadsheet, or image. While the number of
attachments per record is theoretically unlimited, the total size of attachments
is limited by the maximum database size.

Attachment

An expression that brings together data from one or more fields.Calculated
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 Exercise 7: Determining Data Types
 5 to 15 minutes

In this exercise, you will assign data types to the columns in a table.

Open .../ClassFiles/Tables/Exercises/Exercise - Contacts Table.pdf. Which data
type would you assign to each column in the Contacts table? Explain your choices for the
Zip and Cell columns.
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Solution

Suggested data types:

Data TypeColumn

AutoNumberContact ID

Short textLast Name

Short textFirst Name

Short textMI

Short textAddress

Short textCity

Short textState

Short textZip

Short textCell

Date/TimeBirthdate

Yes/NoRelative?

While the Zip and Cell columns store numbers, the numbers cannot be used in any
meaningful computations; therefore, storing them as text is sufficient.

❋

4.3. Create a Table in Design View

We’ll use the Contacts table from the last exercise to demonstrate how to create a table
in Design view. It is often helpful to add a Table Description of the general purpose and
topic for each table in Design View using the Properties Sheet.
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To create the table in Design view:

1. Open the database. (For this demonstration, we’ll use “My New Database.accdb”.)

2. Create a new table by clicking Create > Tables > Table.

3. In the Navigation Pane, Table1 should be open on the work surface.

4. On the Home tab, in the Views group, click . Name the table Contacts, click
OK. Notice that the ID field that Access automatically created is carried over for
you. We’ll keep the field but rename it.

5. In the Field Name column in the first row, rename the field “ContactID”.
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Note

When naming the columns of a table, it is good practice to leave out any
spaces in the name.Typically, an application developer will ignore the spaces
or replace them with underscores (_).While spaces are allowed, field names
with spaces must be enclosed in quotation marks when referenced in SQL
statements or VBA code.

6. In the Data Type column, accept the default of “AutoNumber”.The ContactID field
will serve as our record ID, so we will allow Access to automatically generate it
for us.

7. The Description field is optional. However, since the description will display in
the status bar for our users, it is good practice to give them a hint about the field.
For the ContactID field, type “Record number automatically assigned by Access.”

Notice the key  to the left of the row. It denotes that the ContactID field
is the primary key for the Contacts table. Since we started with a table
that Access automatically created, the primary key is set for us by default;
however, it can be changed if necessary.

To set a primary key, place your cursor in the row of the field you want to
make the primary key and click Primary Key in the ribbon. The key 
appears to the left of the primary key row.

We created the ContactID field for the purpose of serving as a unique key,
so we will leave it as is.

8. In the Field Properties area, on the General tab, we will accept the defaults that
Access recommends. However, we will provide our own caption. Earlier we
recommended that you remove spaces from the field name. The caption is our
opportunity to provide the label we want the users to see when this field appears
on a form or report. In the Caption field, type “Contact ID”:
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The Indexed Property

Before we move on, a few words about the Indexed property are in order.
An index holds the locations of records in the database using the fields which
are indexed as points of reference. Access can create indexes on fields to
speed up searching and sorting. While indexing improves searching and
sorting performance, the tradeoff comes in slower performance when updating
the database. For this reason, you should be selective in choosing the fields
you want Access to index, giving preference to fields that users are most
likely to need to perform searches on. Primary key fields should always be
indexed.

There are three options for the Indexed property:

No - An index will not be created for the field.

Yes (Duplicates OK) - An index will be created. Duplicate values are
allowed in the field.

Yes (No Duplicates) - An index will be created. Values in the field
must be unique.

Because key fields must be unique, the Indexed property should be set to
“Yes (No Duplicates)”.

9. In the second row of the field definition area, enter the following information for
the Last Name field:

Field Name: LastName
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Data Type: Short Text

Description: Enter the contact’s last name.

10. In the Field Properties area, on the General tab, enter values for the following
properties:

Field Size: 20.The default field size for a short text field is 255 characters.
Setting a value here lets us control the length of data a user can input.

Caption: Last Name

Required: Yes. Setting the Required property to “Yes” tells Access to
insist that users enter a value in this field.

Indexed: Yes (Duplicates OK)

11. In the next row of the field definition area, enter the following information for the
First Name field:

Field Name: FirstName

Data Type: Short Text

Description: Enter the contact’s first name.
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12. In the Field Properties area, on the General tab, make the following entries:

Field Size: 20

Caption: First Name

13. In the next row of the field definition area, enter the following information for the
MI field:

Field Name: MI

Data Type: Short Text

Description: Enter the contact’s middle initial.

14. In the Field Properties area, on the General tab, make the following entries:

Field Size: 1

Caption: MI
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15. In the next row of the field definition area, enter the following information for the
Address field:

Field Name: Address

Data Type: Short Text

Description: Enter the street number and street name of the contact’s
address.

16. In the Field Properties area, on the General tab, make the following entries:

Field Size: 30

Caption: Address
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17. In the next row of the field definition area, enter the following information for the
City field:

Field Name: City

Data Type: Short Text

Description: Enter the city of the contact’s address.

18. In the Field Properties area, on the General tab, make the following entries:

Field Size: 25

Caption: City
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19. In the next row of the field definition area, enter the following information for the
State field:

Field Name: State

Data Type: Short Text

Description: Enter the two-character state abbreviation of the contact’s
address.

20. In the Field Properties area, on the General tab, make the following entries:

Field Size: 2

Caption: State
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21. In the next row of the field definition area, enter the following information for the
Zip field:

Field Name: Zip

Data Type: Short Text

Description: Enter the contact’s zip code.

22. In the Field Properties area, on the General tab, make the following entries:

Field Size: 9

Input Mask: 00000/-9999;;_

An input mask assists users with data input by applying formatting
as they type.

To define an input mask for a zip code field:

1. Click the  ellipsis button in the Input Mask field.

2. When prompted to save the table, click Yes. The Input
Mask Wizard starts.
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3. In the list box, highlight the Zip Code mask.

Tip: To verify that the mask is the one you need, you can
type a value in the Try It field to simulate the behavior of
the mask.

4. Click Next >.
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The Input Mask field gives you the opportunity to
make changes to the layout of the mask. For the
Zip Code mask, 0s represent required entries and
9s represent optional entries. For example, if we
don’t need to allow Zip+4 zip codes, we could
change the mask to “00000”.

The Placeholder character field allows you to
select the character which displays as users input
values in the field. If you want to change the
placeholder, select a different placeholder from
the drop-down list.

5. After you make the changes you want, click Next >.
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You can store zip codes with or without the dash. Saving
without the dash represents a savings in disk space.
However, if you find it more meaningful to view the data
in the table in formatted form, you may want to save the
data with the dash. If you store the dash, ensure that the
field size is large enough to accommodate it.

6. Click Next >.

7. Click Finish.

Caption: Zip
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23. In the next row of the field definition area, enter the following information for the
Cell field:

Field Name: Cell

Data Type: Short Text

Description: Enter the contact’s cell phone number.

24. In the Field Properties area, on the General tab, make the following entries:

Field Size: 10

Input Mask: !/(999“) ”000/-0000;;_

To define a mask for the cell phone number:

1. Click the  ellipsis button in the Input Mask field.

2. At the prompt to save the table, click Yes.The Input Mask
Entry wizard starts.

3. Highlight the Phone Number mask and click Next >.
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Notice that the phone number mask is preceded by an
exclamation mark (!). This indicates that the mask should
fill from left to right instead of right to left.

The area code portion of the phone number is set to “999”.
If you want to require an area code in every cell phone
number, you can change this part of the mask to “000”.

4. Click Next >.

5. Select how to store cell phone numbers in the database,
then click Next >.

6. Click Finish.

Caption: Cell
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25. In the next row of the field definition area, enter the following information for the
Birthdate field:

Field Name: Birthdate

Data Type: Date/Time

Description: Enter the contact’s date of birth.

26. In the Field Properties area, on the General tab, make the following entries:

Format: Short Date. Select the date format from the drop-down list.
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Caption: Birthdate

Validation Rule: >=Now() We can ensure that a user doesn’t accidentally
enter a future date in this date field. To do this, we’ll use the Expression
Builder to define a rule that the database will check against to decide if
an entry is valid. We will create an expression that checks that the date
entered is less than or equal to the current date and time.

To create the validation rule:

1. Click the  ellipsis button in the Validation Rule field.
The Expression Builder opens.

2. In the Expression Elements list box, highlight Operators.
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3. In the Expression Categories list box, highlight
Comparison.

4. In the Expression Values list box, double-click >=.
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5. Next, in the Expression Elements list box, expand the
Functions branch and highlight Built-In Functions.

6. In the Expression Categories list box, highlight
Date/Time.

7. In the Expression Values list box, double-click Now.

8. Click OK. The expression loads in the Validation Rule
field.

Validation Text: The date must be prior to the current date. This is the
text of the message that displays to the user if an invalid date is entered.

Show Date Picker: Select “For dates” if you want the field to include a
calendar control that users can use to select a date. Otherwise, select
“Never”.
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27. In the next row of the field definition area, enter the following information for the
Relative field:

Field Name: Relative

Data Type: Yes/No

Description: Mark the check box if the contact is a relative.

28. In the Field Properties area, on the General tab, make the following entries:

Format: Yes/No

Caption: Relative

Default Value: No. Generally speaking, you should set the Default Value
property to the more likely value. In this case, we’re assuming that more
contacts will be non-relatives than relatives.
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29. Select the Lookup tab.

30. In the Display Control field, select the type of control to use for the Relative field.
Your options are:

Check Box - Users will mark or clear a check box.

Text Box - Users will type a value in a text field.

Combo Box - Users will select a value from a drop-down list.
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31. Save your changes.

32. Close the table.

33. Rename the table to “Contacts”.

 4.3.1. Delete a Field

When a field is deleted, the data will be removed, and there is no way to recover the data.

If there are records, then you will be warned about the permanent deletion.
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 4.3.2. Rename a Table

There will be times when you must rename a table. Before you do, please be aware that
any objects that are dependent on the Table will need to be updated as well. Access does
not rename references for you as other technologies do.

1. Right-click the table that you wish to rename.

2. Choose Rename.

3. Type the new name and hit the Enter key to confirm the name.

Undo

Note that you will have a chance to CTRL+Z to undo right away.
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 Exercise 8: Creating a Table in Design
View

 15 to 45 minutes

Create a Transactions table in the Bank Register - Before.accdb database located in your
.../ClassFiles/Tables/Exercises/Bank Register - Before.accdb folder. Refer to the
sample Transactions table in the Exercise - Transactions.pdf file located in the same folder.
Make the Trans ID field the primary key.
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Solution

To create the Transactions table:

1. Open the database.

2. On the Create tab, click Table Design. Table1 opens in Design view.

3. In the first row of the field definition area, enter the following information for the
Trans ID field:

Field Name: TransID

Data Type: AutoNumber

Description: Record number automatically assigned by Access.

4. To make the TransID field the primary key, ensure your cursor is in the TransID
row and click Primary Key in the ribbon. Notice that the  key appears to the left
of the row.

5. In the Field Properties area, on the General tab, make the following entry:

Caption: Trans ID
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6. In the next row of the field definition area, enter the following information for the
Code field:

Field Name: Code

Data Type: Short Text

Description: Enter a transaction code or check number.

7. In the Field Properties area, on the General tab, make the following entries:

Field Size: 5

Caption: Code

Required: Yes
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8. In the next row of the field definition area, enter the following information for the
Credit field:

Field Name: Credit

Data Type: Yes/No

Description: Mark the check box if this is a credit transaction.

9. In the Field Properties area, on the General tab, make the following entry:

Caption: Credit

128 | LESSON 4: Tables

EVALUATION COPY: Not to be used in class.



10. In the next row of the field definition area, enter the following information for the
Date field:

Field Name: TransDate (We are using TransDate instead of “Date”
because Access considers “Date” a reserved word.)

Data Type: Date/TIme

Description: Enter the transaction date.

11. In the Field Properties area, on the General tab, make the following entries:

Format: Short Date

Caption: Date

Required: Yes
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12. In the next row of the field definition area, enter the following information for the
Description field:

Field Name: Description

Data Type: Short Text

Description: Enter the payee or a description of the transaction.

13. In the Field Properties area, on the General tab, make the following entries:

Field Size: 50

Caption: Description

Required: Yes
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14. In the next row of the field definition area, enter the following information for the
Amount field:

Field Name: Amount

Data Type: Currency

Description: Enter the amount of the transaction.

15. In the Field Properties area, on the General tab, make the following entries:

Caption: Amount

Required: Yes
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16. In the next row of the field definition area, enter the following information for the
Memo field:

Field Name: Memo

Data Type: Short Text

Description: Enter a memo about the transaction (optional).

17. In the Field Properties area, on the General tab, make the following entries:

Field Size: 40

Caption: Memo
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18. In the next row of the field definition area, enter the following information for the
Cleared field:

Field Name: Cleared

Data Type: Yes/No

Description: Mark the check box if the transaction has cleared the bank.

19. In the Field Properties area, on the General tab, make the following entry:

Caption: Cleared
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20. Save the table.

21. Close the table.

22. Rename the table “Transactions”.

Conclusion

In this lesson, you learned:

To create a blank database.

To create a table in Design view.

About the data types supported by Access.

To set a primary key.

To use the Input Mask Wizard.

To use the Expression Builder to define validation rules.
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LESSON 5
Queries

Topics Covered

 Queries and query views.

 Creating a simple query.

Introduction

In this lesson, we’ll focus on the database objects you can use to retrieve data from tables
(queries).

For this lesson, open files located with your Webucator class files at ClassFiles/In
tro_Queries/Demos/. If prompted concerning disabled content, click Enable Content in
the yellow banner.

❋

5.1. Queries

 5.1.1. Definition and Purpose

A query is a way for you to describe what data you want to see and then have Access
fetch that data and either return it to you or perform some action on that data. Queries are
especially powerful because they can pull together data from multiple related tables and
other queries. Queries are frequently used as the basis for data entry forms and for reports.

 5.1.2. Types

The two main types of queries supported by Access are select queries and action queries.

Select Queries

A select query retrieves data from your database. Select queries can be used to perform
calculations.
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Action Queries

An action query can add, change, or delete records in your database. An important caveat
about action queries is that they cannot be reversed. You may want to consider backing
up your data before performing an action query.

The types of action queries available in Access include:

Make table - Creates a new table using data from other tables in the database.

Append - Adds records to a table.

Update - Makes changes to records.

Delete - Removes records from a table.

 5.1.3. Views

Similar to tables, queries have a Datasheet view and a Design view. In addition, queries
have a SQL view that allows you to view the query statements that Access interprets to
make the queries work. In fact, if you know SQL (Structured Query Language) you can
write your own query statements directly in the SQL editor.

Open ClassFiles/Intro_Queries/Demos/Demo - My Music Collection - Simple Select

from Multiple Tables.accdb.

To switch among views for a query, select the Home tab, click the drop-down arrow below
the View icon, and select the view you want from the drop-down menu.
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Datasheet View

The Datasheet view for queries resembles the Datasheet view for tables in most respects.

In fact, the procedures for selecting data, filtering, sorting, navigating, searching, adding
new records, and editing records are the same.

To run a select query, you can simply open it in Datasheet view.

Design View

The work of putting your data request into terms that Access can understand occurs in
query Design view.

The query tab in Design view consists of two sections.The top section holds representations
of the tables and queries you want to extract data from.

The bottom section is where you specify the data you want the query to return, how you
want it sorted, and criteria for filtering the data.
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The Property Sheet allows you to set unique attributes for each item.

We will explore Design view in more depth in the advanced course.

SQL View

As you set up a query in Design view, Access builds the equivalent SQL statements.You
can see what those statements look like in SQL view by right-clicking and choosing SQL
View.

Working with SQL statements is beyond the scope of this course; however, viewing the
SQL code and familiarizing yourself with the syntax will deepen your understanding of
how queries work.
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❋

5.2. Select Queries

At the heart of every kind of query is a select query.

Select queries can return a subset of fields from a single table or can aggregate data from
multiple tables.

To create a simple select query showing data from a single table:Open ClassFiles/In
tro_Queries/Demos/My New Database - Simple Select.accdb.

1. Open the database.

2. On the Create tab in the Queries group, click Query Design. The Show Table
dialog box opens.

3. Highlight the table to perform the query on and click Add.

4. Click Close.
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5. In the table, double-click the field names you want to add to the query grid.
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6. On the Query Tools: Design tab in the Results group, click Datasheets view.
The results display in a datasheet.

7. Click Save.

8. In the Save As dialog box, type a name for the query and click OK.
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To run a query after you’ve saved it:

1. Locate the name of the query in the Navigation pane.

2. Double-click the query name.

To write a select query to pull together data from multiple tables: Open ClassFiles/In
tro_Queries/Demos/Demo - My Music Collection - Simple Select from Multiple Ta

bles.accdb.

1. Open the database.

2. On the Create tab in the Queries group, click Query Design. The Show Table
dialog box opens.
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3. Highlight the tables to add to the query and click Add.

4. Click Close.

5. In the tables, double-click the field names you want to add to the query grid.
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6. On the Query Tools: Design tab in the Results group, click Datasheet view.
The results display in a datasheet.

7. Click Save.

8. In the Save As dialog box, type a name for the query and click OK.
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❋

5.3. Select Queries with Criteria

You can select very precise result sets by applying selection criteria to a select query.
Selection criteria let you include or exclude data based on the requirements you specify.

To create a select query with selection criteria: Open ClassFiles/Intro_Queries/Demos/De
mo - My Music Collection - Select Query with Criteria.accdb.

1. Open the database.

2. On the Create tab in the Queries group, click Query Design. The Show Table
dialog box opens.

3. Highlight the tables to add to the query and click Add.
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4. Click Close.

5. In the tables, double-click the field names you want to add to the query design
grid.
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6. In a column for a field you want to limit results by, enter a value or expression in
the Criteria row. To enter more criteria for a single field, use the or rows below
the Criteria row. For examples of acceptable criteria, search Access help for
“examples of query criteria” and see the section on logical operators that follows
this section.
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Note

The result set will include records that satisfy at least one of the criteria
specified for a field. In our example, the result set will include records where
the artist name starts with “C” OR where the artist name is “Beatles”.

7. Enter criteria for other fields as desired.

Note

The result set will include only the records that satisfy all the columns. In our
example, the result set will include records where the artist name starts with
“C” AND the format is “Compact disc” OR records where the artist name is
“Beatles” AND the format is “Compact disc”.

8. On the Query Tools: Design tab in the Results group, click Datasheet view.
The results display in a datasheet.
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9. Click Save.

10. In the Save As dialog box, type a name for the query and click OK.

❋

5.4. Logical Operators

When specifying selection criteria, it’s not always convenient (or possible) to list all the
acceptable criteria values. Usually it’s better to write logical expressions to describe the
criteria. This is where logical operators come in. Logical operators describe how we want
our criteria evaluated. In conjunction with operators, we can use wildcard characters,
symbols such as asterisk (*) that substitute for other characters or strings of characters.

The following table lists common logical operators with examples and explains their use.

ReturnsExampleOperator

Items that start with “C”.Like C*Like

Items that end with “C”.Like *C

Items that contain “C”.Like *C*

All items except those that start with “C”.Not Like C*Not Like

All items except those that end with “C”.Not Like *C

All items except those that contain “C”.Not Like *C*

Items that are blank.Is NullIs Null

All items that are not blank.Is Not NullIs Not Null

Items that match one of the values in the
list.

In (Arizona, New Mexico,
Texas, Oklahoma)

In

Items that don’t match one of the values in
the list.

Not In (Arizona, New
Mexico, Texas, Oklahoma)

Not In

Items that fall between 200 and 400.Between 200 and 400Between and

All items that don’t fall between 200 and
400.

Not Between 200 and 400Not Between
and

Items that are less than 200.< 200<

Items that are less than or equal to 200.<= 200<=

Items that are greater than 400.> 400>

Items that are greater than or equal to 400.>= 400>=
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You can create very specific selection criteria by combining logical expressions.

❋

5.5. Group and Total with Queries

In a query, you will often need to summarize data. The totals row uses Group By to better
structure your data, then choose from options such as SUM to create subtotals. (sample
below uses tables from ../ExtraDatabase/SampleCompany.accdb)

 5.5.1. Totals Row with Group By

1. Click Design > Show/Hide > Totals.

2. Make sure you have your fields arranged left to right in importance. Then choose
Group By to start the process.

3. Choose SUM for the numerical data.

4. The results return the Names, then itemName with a sum of each item number
and price.
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5. Remember, order matters as when we remove the Name field, the results will now
focus on the unique itemNames.

6. See the results below, a summary of each item with the Sum of number and price.
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 Exercise 9: Creating Select Queries
 15 to 25 minutes

In this exercise, you will create a query recordset of uncleared transactions for the Bank
Register database from the ClassFiles/Intro_Queries/Exercises/Bank Register.accdb.
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Solution

First, we will create a select query to select the uncleared transactions and then we’ll
change it to a make table query.

1. Open the database.

2. On the Create tab in the Queries group, click Query Design.

3. In the Show Table dialog box, highlight “Transactions”.

4. Click Add.

5. Click Close.

6. In the table, double-click * to add all fields in the table to the query.
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Hint

Double-clicking * is a quick way to add all the fields in a table to your query.
You can still add a field from the table to use as selection criteria, just make
sure to clear the field’s Show check box so that the field doesn’t appear twice
in your results.

7. In the table, locate and double-click the Cleared field to add it to the query design
grid.

LESSON 5: Queries | 155



8. Clear the check box in the Show row for the Cleared field. (We don’t want the
Cleared field to appear twice in our table.)

9. In the Criteria row for the Cleared field, type “False”. (We want the table to show
only transactions that are not cleared.)
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10. On the Query Tools: Design tab in the Results group, click Datasheet view.

11. View your results.

12. Switch back to Design view and click Save.

13. In the Save As dialog box, type a name for the query and click OK.

Conclusion

In this lesson, you learned:

About the Access queries.

About the views available for working with queries.

About select queries with criteria.
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LESSON 6
Forms

Topics Covered

 Form types.

 Adding records using a form.

 One-click forms.

The Form Wizard.

Introduction

Access lets you decide how much effort to put into creating data entry forms. In this lesson,
we’ll learn how to create forms with a single-click and with the Form Wizard and enter data
into forms. In the advanced course, you will delve deeper into using Design view to create
customized forms. No matter how your form originates, once it’s created you can use
Layout view and/or Design view to improve it.

For this lesson, open files located with your Webucator class files at ClassFiles/Forms/De
mos/. If prompted concerning disabled content, click Enable Content in the yellow banner.

❋

6.1. Forms

 6.1.1. Definition and Purpose

Forms are how you make data accessible to users for viewing, adding, and editing. While
forms are not a technical requirement for a database, they help users make sense of the
data without having to know the intricacies of how the database is structured.Well-designed
forms can help ensure that users always enter valid data and that data is not inadvertently
duplicated.
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 6.1.2. Views

Form objects can be viewed in three ways: Form view, Layout view, and Design view.

Form View

Form view displays a form as it would look to your users. Form view allows access to the
data from the tables and queries on which the form is based so that users can view data,
add records, and edit record values.

Notice that Form view has a record navigator bar like tables have in Datasheet view. The
navigation, filtering, and search tools serve the same purposes in forms as they do in
tables. Unlike the strict column and row layout of tables, however, forms can be laid out
logically and can provide aesthetic appeal to your users.

Open a Form in Form View

To open a form: Open Forms/Demos/My Music Collection.accdb.

1. Locate the form in the Navigation Pane and right-click it.

160 | LESSON 6: Forms

EVALUATION COPY: Not to be used in class.



2. From the drop-down menu, select Open. The form opens in a tab on the Access
work surface.

LESSON 6: Forms | 161



Enter Data in Form View

To add a record in Form view:

1. Open the form.

2. Click the New Record  button in the record navigator bar. A blank record loads
in the form.

3. Press Tab in the ID field to generate a record number and then respond to the
remaining fields with appropriate information.
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If you were to open the table(s) the form is based on, you would see that the record is
added there too.

Sort Records in Form View

To sort records in Form view:

1. Open the form.

2. Select the form field you wish to sort by.
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3. Home > Sort & Filter > Ascending or Descending.

4. Results are now updated.

❋

6.2. Alter a Form

Forms may be altered in a variety of ways that can help you to customize any process.

 6.2.1. Delete Forms

Once a form has served its purpose, you will want to delete it in order to keep your database
efficient.
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1.

Right-click the form you want to delete; be aware that if the form is being used by
other objects, the deletion process may cause issues.

2.

Confirm the action.

 6.2.2. Remove Form Controls

Controls may need to be removed from the various sections of the form. When doing this,
the data will not be affected, and the control may be added back at any time. Open
Forms/Demos/My Music Collection - Add Fields.accdb
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1.

Select the control to remove. Press the Delete key.

2.

The control is removed.
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 6.2.3. Format a Form

There are many options available on the three tabs.

Format Print Layouts

Forms may be printed at anytime. To view and adjust the layout, choose File > Print.

1.

File > Print.
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2.

Print Preview.

3.

The Print Preview Ribbon provides many choices in how the form will be printed.

Change Margins
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Margins can affect how much of the form will fit on a single page.

Insert Backgrounds and Images

Images may help convey a message. By branding a set of forms with a logo or image will
help to categorize and maintain a uniform look.

1.

Format > Background Image >Browse...

2.

Choose the proper image. Click OK.
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3.

The image is now placed in the center of the form.
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 Exercise 10: Adding Data Records in Form
View

 15 to 25 minutes

In this exercise, you will add two records to the Recordings table using the Manage My
Recordings form. Use the ClassFiles/Forms/Exercises/Exercise - My Music Collec

tion.accdb database.

Add the following records:

FormatArtistTitle

45Nat King ColeUnforgettable

MP3Natalie ColeUnforgettable
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Solution

To add the recordings:

1. Open the Manage My Recordings form.

2. In the record navigator bar, click .

3. Press Tab in the ID field to generate a record number.

4. In the Title field, type “Unforgettable”.

5. In the Artist field, type “Nat King Cole”.

6. In the Format field, type “45”. When you tab out of this field, a new record is
automatically loaded for you.

7. In the Title field, type “Unforgettable”.

8. In the Artist field, type “Natalie Cole”.

9. In the Format field, type “MP3”.
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❋

6.3. Form Record Navigation

At the bottom of a form’s tab is the record navigation bar.

The first section of the bar is the record navigator. The buttons of the record navigator
allow you to move quickly to the first record , the previous record , the next record ,
and the last record  in the table. The last button  in the record navigator adds a new
blank record to the table.

In the middle of the record navigator is the current record indicator which shows the record
currently selected in the form and the total number of records in the table.You can select
the text in the current record box, type a record number, and press Enter to move quickly
to that record in the table.
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To the right of the record navigator is a button that indicates whether the table is filtered
or unfiltered. Clicking Unfiltered applies the last saved filter on the table. As noted earlier,
clicking Filtered removes filtering.

The last item on the record navigator is a search box.

As you type in the search box, the cursor moves to the first value in the table that matches
what you’ve typed. After you find your search term, you can press Enter again to find the
next instance of the search term in the table.

❋

6.4. Layout View and Design View

Layout view looks very similar to Form view; however, its purpose is similar to that of the
form Design view. Both allow you to work with the design of the form. Layout view lets you
work with the form in a visual format (sometimes called WYSIWYG or “what you see is
what you get”) while Design view allows you to work with the design from a structural point
of view. Many design changes can be made from either view; however, some changes
can only be accomplished in Design view. Use the ClassFiles/Forms/Exercises/Exercise
- My Music Collection.accdb database.
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❋
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6.5. One-Click Forms

Access provides some basic forms which you can create simply by highlighting the table
or query you want to base the form on and then clicking an icon or selecting a form type
from a menu.

In this section, we’ll demonstrate four of the one-click forms.

 6.5.1. Basic Data Entry Form

To create a data entry form which displays one record at a time: Use the Class
Files/Forms/Demos/My New Database - Before.accdb database.

1. In the Navigation Pane, highlight the table to base the form on.

2. On the Create tab in the Forms group, click Form. The new form loads on the
work surface.

3. Click Save.You are prompted to name the form.
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4. Enter a name for the form and click OK.

 6.5.2. Basic Multi-Record Form

To create a form that shows multiple records at a time:

1. In the Navigation Pane, highlight the table to base the form on.

2. On the Create tab in the Forms group, click More Forms and select Multiple
Items from the drop-down menu.

The form loads on the work surface.
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3. Name and save the form.

 6.5.3. Datasheet Form

A datasheet form resembles the Datasheet view of a table.

To create a datasheet form:

1. In the Navigation Pane, highlight the table to base the form on.

2. On the Create tab in the Forms group, click More Forms and select Datasheet
from the drop-down menu. The form loads on the work surface.
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3. Name and save the form.

 6.5.4. Split Form

A split form combines a single-entry form with a datasheet. When a user edits records in
a split form, the record that is selected in the datasheet is loaded in the data entry form.

To create a basic split form:

1. In the Navigation Pane, highlight the table to base the form on.

2. On the Create tab in the Forms group, click More Forms and select Split Form
from the drop-down menu. The form loads on the work surface.
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3. Name and save the form.

❋

6.6. Form Wizard

The Form Wizard gives you more control over your results than one-click forms do. The
wizard lets you make decisions about certain aspects of a form’s design and produces a
form based on your instructions.

 6.6.1. Create a Form with the Form Wizard

To create a form based on a single table using the Form Wizard:

1. On the Create tab in the Forms group, click Form Wizard. The wizard starts.
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2. From the Tables/Queries drop-down list, select the table (or query) to base the
form on. The fields for the selected table load in the Available Fields list box.

3. Move the fields to include on the form from the Available Fields list box to the
Selected Fields list box.To do so, double-click a field name to move it or highlight
the field name and click >. To move all fields at once, click >>.

4. Click Next >.
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5. Select the layout for the form.Your options are “Columnar”, “Tabular”, “Datasheet”,
and “Justified”. Tip: Select each of the options to see a preview of the form layout
before you make a final selection.

6. Click Next >.

7. Enter a title for the form.

8. Select an option for the view you want to open the form in.Your options are:
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Open the form to view or enter information - Opens in Form view.

Modify the form’s design - Opens in Design view.

9. Click Finish. The form loads in the view you selected.
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 Exercise 11: Creating a Form with the
Form Wizard

 15 to 35 minutes

Use the Form Wizard to create a columnar form based on the Transactions table in the
Bank Register database in the ClassFiles/Forms/Exercises folder. Include all fields except
the TransID field. (Record numbers will be generated whether or not the key field is included
on the form.) Name the form “Transaction Entry”.
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Solution

To create the form:

1. Open the database.

2. On the Create tab in the Forms group, click Form Wizard.

3. In the Tables/Queries field, ensure that the Transactions table is selected.

4. Click >> to move all fields from the Available Fields list box to the Selected Fields
list box.
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5. In the Selected Fields list box, double-click TransID to move it back to the
Available Fields list box.

6. Click Next >.
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7. Accept the “Columnar” option. Click Next >.

8. In the What title do you want for your form? field, type “Transaction Entry”.
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9. Click Finish.

Conclusion

In this lesson, you learned:
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To about types of forms.

To add records using a form.

To create simple forms using Access’s built-in one-click forms.

To create forms using the Form Wizard.
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LESSON 7
Reports

Topics Covered

 Reports.

The one-click report.

The Report Wizard.

Introduction

For this lesson, open the My Music Collection database located with your Webucator class
files at ClassFiles/Reports/Demos/My Music Collection.accdb. If prompted concerning
disabled content, click Enable Content in the yellow banner.

❋

7.1. Reports

 7.1.1. Definition and Purpose

Reports are a practical way to share data with others. Reports can be printed, saved as
PDF, emailed to others, or exported to an Excel file. Reports are typically based on one
or more tables or queries.

 7.1.2. Views

Reports offer four views: Report view, Layout view, Design view, and Print Preview.

Report View

Report view is analogous to Form view for forms. Report view renders the report as the
user will experience it.

To open a report object in Report view, highlight the report name in the Navigation Pane
and double-click.
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Layout View and Design View

Layout view and Design view are also similar to their forms namesakes. Both allow you
to work with the design of a report: Layout view from a visual perspective and Design view
from a structural perspective.
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Print Preview

Print Preview is a special view for reports that allows you to tweak page settings before
you print a report. Print Preview also offers different output methods including email, PDF,
and Excel spreadsheet.

LESSON 7: Reports | 193



 7.1.3. One-Click Report

Access offers a single one-click report.

To create a one-click report: Open ClassFiles/Reports/Demos/My New Database - Be

fore.accdb.

1. In the Navigation Pane, highlight the table to base the report on.

2. On the Create tab in the Reports group, click Report. The report loads on the
work surface.
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3. Click Save.You are prompted to name the report.

4. Type a name for the report and click OK.

Note

The dashed lines on the report indicate page boundaries. This attempt at a contacts
report would require further tweaking in Layout view or Design view to be usable.

❋
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7.2. Report Wizard

Similar to the Form Wizard, the Report Wizard steps us through a series of decisions in
order to build a report.

 7.2.1. Create a Report Using the Report Wizard

To create a report using the Report Wizard: Open ClassFiles/Reports/Demos/My New

Database - Before.accdb.

1. On the Create tab in the Reports group, click Report Wizard. The wizard starts.

2. From the Tables/Queries drop-down list, select the table (or query) to base the
report on. The fields for the selected table load in the Available Fields list box.

3. Move the fields to include on the report from the Available Fields list box to the
Selected Fields list box.To do so, double-click a field name to move it or highlight
the field name and click >. To move all fields at once, click >>.
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4. Click Next >.

5. To group records on the report by a particular field, highlight the field in the list
box and click >.
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6. Add more grouping levels if desired. You can use the arrows to change the order
of the grouping levels if needed.

7. When you finish defining how you want records grouped, click Next >.

8. In the first drop-down list, select the field to sort records by. By default, records
will be sorted in ascending order by the field you select. If you want to sort in
descending order, click the Ascending button to change its label to “Descending”.
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9. You can specify up to four levels of sorting. When you finish specifying sorting
options, click Next >.

10. In the Layout field, select the format of the report. Your options are “Stepped”,
“Block”, and “Outline”. (Try the options to see a preview of the report layouts.)

11. In the Orientation field, select whether to lay out the report in portrait or landscape
mode.
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12. If you want all fields to fit on a single page, ensure the Adjust the field width so
all fields fit on a page check box is marked.

13. Click Next >.

14. Enter a title for the report.

15. Select an option for the view you want to open the report in.Your options are:

Preview the report - Opens in Print Preview mode.

Modify the report’s design - Opens in Design view.

16. Click Finish. The report loads in the view you selected.
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Once the wizard has done its job, then future changes to the Sorting and Grouping
are made in the Group, Sort, and Total area: Design > Group & Sort. You may
change the order, remove, or edit any existing items. You may also add a group
and a sort as well.
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 Exercise 12: Creating a Report with the
Report Wizard

 15 to 35 minutes

Use the Report Wizard to create a report based on the Transactions table in the Bank
Register database in the ClassFiles/Reports/Exercises folder. Include all fields except
the TransID field. Group by TransDate and sort in ascending order by Code. Use block
layout and portrait orientation. Name the report “Transaction Listing”. View the report in
Print Preview mode.
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Solution

To create the report:

1. Open the database.

2. On the Create tab in the Reports group, click Report Wizard.

3. In the Tables/Queries field, ensure that the Transactions table is selected.

4. Move all fields except the TransID field from the Available Fields list box to the
Selected Fields list box.
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5. Click Next >.

6. In the list box, highlight “TransDate”, then click >.
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7. Click Next >.

8. From the first drop-down list, select “Code”.
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9. Click Next >.

10. In the Layout field, select “Block”.

LESSON 7: Reports | 207



11. Click Next >.

12. In the What title do you want for your report? field, type “Transaction Listing”.
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13. Click Finish.

Conclusion

In this lesson, you learned:

To understand reports.
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To create a one-click report.

To create a report using the Report Wizard.
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LESSON 8
Optional: Databases and Access Terms

Topics Covered

What is a database?

 Database vs. spreadsheet.

Where Excel excels.

 Relational databases.

What is an RDBMS?

What is Microsoft Access?

 Benefits and limitations of Access.

Introduction

In this lesson, you will learn what a database is, how a database is different from a
spreadsheet, where Excel excels and where it doesn’t, how to choose whether to use a
spreadsheet or a database for your purpose, what a relational database is, what a relational
database management system (RDBMS) is, what Microsoft Access is, and some benefits
and some limitations of Access.

❋

8.1. “Database” Defined

A database is a collection of related information organized so that the information can be
searched, retrieved, and manipulated.The information collected is commonly called data.

This basic definition reveals some essential characteristics of a database. Namely, a
database:

Stores data.

Ideally only stores data relevant to its purpose.

Has a meaningful structure.
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Is searchable.

Returns the data its users need in a form that is useful to them.

The purpose of this course is to teach you about the tools that Microsoft Access provides
to help you create applications that collect data, store it, find it, and output it.

❋

8.2. Databases vs. Spreadsheets

Users often turn to databases when they feel they’ve reached the limits of what they can
manage with spreadsheets. In this section, we’ll explore how to know if you’re choosing
the right tool for the job.

Databases and spreadsheets share some common characteristics. Both provide a means
for collecting data. Data in both can be filtered, sorted, and searched. Both spreadsheets
and databases rely on a table structure.

212 | LESSON 8: Optional: Databases and Access Terms

EVALUATION COPY: Not to be used in class.



Despite some similarities, spreadsheets and databases have certain strengths and
weaknesses that make them suited to different tasks. The table below provides a
comparison of the two.

SpreadsheetDatabase

Simple to createLabor-intensive setup

Easier for novices to get startedSomewhat steep learning curve

Flat structure: one tableRelational structure: multiple tables

Displays all dataOnly displays the data the user needs

Size is limited by computer resourcesCan handle large amounts of data

The first user with access locks other users
out. Other users can “read” data, but cannot
change it.

Multiple simultaneous users

Easy to introduce errors when updatingEasy to update

Data formats are enforcedData formats (e.g., text, date, currency) are
enforced plus field size constraints, required
fields, default values, and data validation.

Powerful graphing, charting, and analysis
tools

Limited graphing and charting capability

Extensive mathematical and financial
calculations; what-if scenarios; cost-benefit
analysis

Limited calculations outside of reports

Prone to redundant and unreliable dataSafeguards against duplicate data and data
corruption

Low maintenanceOnce established, low maintenance

Best-suited to time-bounded data collection
and analysis projects

Well-suited to long-term storage and data
use

Limited querying toolsRobust querying ability

Frequent copying of a spreadsheet can result
in numerous “out-of-sync” versions of the
spreadsheet

No need to create copies of the database
(except for backup)

In summary, if you need a tool that is relatively easy to learn and use, that is flexible with
enhanced financial, mathematical, and analytical capabilities, a spreadsheet may be the
better solution. On the other hand, if capacity, efficiency, data integrity, and multi-user
capability are important, you should consider using a database.
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 8.2.1. Questions to Ask When Deciding Whether to Use a
Spreadsheet or a Database

Does the data require multiple tables or is a single table sufficient?

Is the data mostly text or mostly numbers?

Is there a lot of repeated data?

Do I need to track actions or events?

Is ease of use or efficiency a greater priority?

How much data do I need to store?

Do I need to store and access the data on an ongoing basis or are my needs
short-term?

Is data reliability important?

Is data corruption a concern? In other words, if I lost the data, would it be difficult
to reproduce?

How many users need access to the data?

Do I need to produce complex reports from the data?

Will other users need help with data entry?

❋

8.3. Access vs. Excel

Microsoft offers both a spreadsheet application, Excel, and a database application, Access.
The general comparisons of databases and spreadsheets discussed above apply to Access
and Excel as well. In particular...

The strengths of Excel include:

Mathematical and financial calculations

Data analysis

Pivot tables

Charting and graphing

User familiarity

The strengths of Access include:

Accuracy
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Efficiency

Capacity

Multiple tables

Data entry

Reporting

Multiple simultaneous users

In addition, choosing Access doesn’t mean you have to give up the features of Excel. In
fact, Access includes an export feature that allows you to send data from your database
to an Excel spreadsheet where you can take advantage of Excel’s calculation, analysis,
and data visualization tools. We’ll talk about that feature in the advanced course.

 8.3.1. Discussion Questions

For the examples below, decide whether the data described is better suited to a
spreadsheet or a database. Why?

An employee list with one name, address, phone number, and birth date for each
employee.

Product sales data including product, manufacturer, manufacturer’s contact
information, quantity sold, unit cost, and sales price.

Student data including names, addresses, birth dates, and exam grades.

❋

8.4. “Relational Database” Defined

A relational database is a collection of data sets organized in multiple tables. Each table
in a relational database has well-defined relationships with one or more other tables in the
database. These relationships make it easy for the tables to share data and, as we will
see in later lessons, to search, retrieve, and report on the data.

Consider the following tables. The first table contains a list of recordings and the second
is a list of recording formats.
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Recordings
FormatArtistTitle

78Count Basie and His OrchestraRight On

8-trJim CroceI Got a Name

33Cleveland OrchestraSmetana: Moldau, Overtures

33BeatlesA Hard Day’s Night

CDBeatlesThe White Album

CassDonna SummerI Remember Yesterday

CDCleveland OrchestraRachmaninov Piano Concerto 1 & 3

MP3Carrie UnderwoodJust a Dream

MP3Alfie BoeMusic of the Night

CDCount Basie and His OrchestraKing of Swing!

Recording Formats
DescriptionFormat

Acetate discACE

78 RPM vinyl record78

45 RPM vinyl record45

33 1/3 RPM vinyl record33

Cassette tapeCass

8-track tape8-tr

Compact discCD

MP3 fileMP3

What do the tables have in common?

Notice that both tables store recording formats. Notice also that the formats occur exactly
once in the Formats, but occur 0, 1, or more times in the Recordings table. We can define
a relationship between the Formats and the Recordings table based on this common
information. We call this sort of relationship a one-to-many relationship since there is only
one of each value in the Formats but these values can correspond to multiple values in
the Format column of the Recordings table.
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 8.4.1. Terminology

Data tables are organized into columns and rows. The label at the top of each column is
commonly called a field name. The values in a column are the values that the field takes
on in data records. Each row in a data table represents a record in the table. The
Recordings table above has three fields and ten records. The Formats has two fields and
seven records. To add another record to a table, we simply add a new row and fill in data
for each of the fields.

 8.4.2. Observations

In our example above, we have multiple tables (2) and we can define a relationship between
the tables based on the format data they have in common. These tables, with a defined
relationship, satisfy our definition of relational database.
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 Exercise 13: Understanding Relational
Databases
 5 to 15 minutes

Often, the existence of repeating values in a field signals an opportunity to create additional
tables and relationships to streamline the database. Looking back at the Recordings and
Formats in this lesson, define a third table and describe its relationship to the other tables.
Sketch out the table on paper, showing field(s) and data value(s).
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Solution

The Artist field in the Recordings table has repeated values.We can create an Artists table
to hold those values.

Artists
Name

Count Basie and His Orchestra

Jim Croce

Cleveland Orchestra

Beatles

Donna Summer

Carrie Underwood

Alfie Boe

The Artists table has a one-to-many relationship to the Recordings table. It has no apparent
relationship to the Formats.

❋

8.5. “Relational Database Management System” (RDBMS)
Defined

A relational database management system (RDBMS) is software that stores relational
data and provides the mechanisms to work with it. Tools in an RDBMS help you add and
manipulate the data, retrieve specific subsets of data, generate reports, and share data.

Specific features of an RDBMS include:

Table structure

Enforcement of relationships and data integrity

Multiple user capability

Ability to prevent unauthorized users from accessing data

Query language support (i.e., a means to tell the system what information you
want to retrieve)

Utilities for maintaining and backing up the database
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Support for access to the database across a network

❋

8.6. Access is an RDBMS

Microsoft Access is a relational database management system. First, Access supports
relational databases: data is stored in tables and Access provides a way to define
relationships among those tables. Furthermore, Access includes a number of tools for
working with data, including:

Querying, sorting, and filtering tools for data retrieval

Form building for data entry

Report building for data presentation

A macro language for task automation

Supporting functions such as data import and export, data backup, and password
protection

❋

8.7. Creating a Relationship

In Access, you must establish the relationships using the Relationships window.

1. Choose Database Tools > Relationships > Relationships.

2. You must choose the tables to include.
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3. Drag the Primary Key from the Parent Table to the Foreign Key of the Child Table.

4. Choose the options for the relationship.
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5. Repeat as needed and your Relationship window should be complete.

❋

8.8. Benefits and Limitations of Access

Aside from the features just listed, Microsoft Access is a valuable tool for other reasons.
As part of the Microsoft Office Suite, Access integrates seamlessly with other Office
applications, particularly Excel and Word. This is handy if you need to export data from
Access for analysis in Excel or if you need to use contact data stored in Access as the
data source for a mail merge in Word.

Access appeals to a variety of skill levels. Access provides database templates which
produce fully functioning databases, so novice users can create a database in mere
minutes. Forms created in Access simplify data entry for users of any skill level. For users
who need a custom database, Access provides wizards to simplify the processes of creating
tables, forms, queries, and reports. For advanced users, Access provides a VBA (Visual
Basic for Applications) editor so users with programming skills can work in the code behind
the database objects.

The main potential drawbacks of using Access as a database solution are database size
and performance limitations. The maximum size for an Access database file is 2GB. This
is adequate for most personal database users and small businesses, but if your data
storage needs are large, you should take this limitation into consideration. Also, while
Access applications can be distributed for use among multiple users, the performance of
an Access application will degrade as the number of concurrent users (users using the
application at the same time) increases.
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 8.8.1. Discussion Questions

Thinking back to the example of the Recordings and Formats, suppose you need to store
the year that each of the recordings was released. How could you include that information
in the database? Would an additional table be needed? Why or why not?

Conclusion

In this lesson, you learned:

What a database, relational database, and relational database management system
are.

Guidelines for choosing whether to use a database or spreadsheet; in particular,
whether to use Access or Excel.

That Microsoft Access is an RDBMS suitable for users with a variety of skill levels
where data storage needs are modest and where there are relatively few concurrent
users.
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